AVR461: Quick Start Guide for the Embedded Internet Toolkit

Introduction
Congratulations with your AVR Embedded Internet Toolkit. This Quick-start Guide gives an introduction to using the AVR Embedded Internet Toolkit and can be used as a guide for getting started with embedded Internet applications.

System Requirements
The minimum hardware and software requirements are:

- PC with 486 Processor (Pentium® is recommended).
- 16 MB RAM.
- 3 MB Free Hard Disk Space.
- Windows® 95/98/2000 or Windows NT® 4.0 or Higher.
- RS-232 Port (COM Port).
- Ethernet Network Connection or Ethernet Network Card with 10BaseT Interface (Twisted Pair, RJ45 Connector), web browser Installed, Internet Explorer or Netscape.

To modify the source code of the Toolkit, the following items are required:

- IAR C-compiler or Imagecraft™ C-compiler.
- STK500 Starter Kit or Other Programming Equipment Capable of In-System Programming megaAVR™.
Connections to the Toolkit

To use the Toolkit, an Ethernet connection is required, either through a network or directly to a PC.

The Ethernet interface connector is of standard RJ-45 type. Plug the Ethernet cable directly into the Toolkit to connect to the Ethernet network or PC.

Setting Up and Testing the Ethernet Connection

The descriptions below explain how to connect the Toolkit to an existing Ethernet network or directly to a PC if a network is not available, then how to test either connection.

The PC is Not Connected to Network

If the PC is equipped with an Ethernet network card but not connected to a network (see Figure 2), a local network address should be used for communication between the Embedded Internet Toolkit and the PC. The Embedded Internet Toolkit is shipped with the default IP address 169.254.111.111. This address is in the address area reserved for local networks not connected to the Internet. For direct connection between the PC and the Toolkit, a crossover Ethernet cable is required. The yellow Ethernet cable provided with the Toolkit is a crossover cable.
Figure 2. The PC is Connected Directly to the EIT

To set up your PC to connect directly to the Embedded Internet Toolkit, an IP address in the same range as the Toolkit’s must be assigned to the PC. In Windows® environments, this should be done as follows (some Windows® versions might deviate slightly in appearance):

- Connect the PC and the Toolkit with the yellow (crossover) Ethernet cable.
- Open the Windows® Control Panel.
- Select Network.
- Select TCP/IP -> the PC’s Ethernet adapter from the Configuration tab as shown in Figure 3.

Figure 3. TCP/IP Configuration

- Push the Properties button. A TCP/IP Properties box similar to Figure 4 should appear.
Figure 4. TCP/IP Properties

- Select the IP Address tab.
- Choose to Specify an IP address as shown in Figure 4.
- Insert the IP address 169.254.111.150 and the corresponding subnet mask as shown in Figure 4.
- Save your settings by pressing OK in both TCP/IP properties and Network properties.
- Reboot your PC.
The PC is Connected In Network

If there is an Ethernet network available (see Figure 5), the Embedded Internet Toolkit can be connected to any Ethernet connection or hub belonging to the network. If the PC is connected to a network, there is a strong possibility that the default IP address of the Toolkit is outside the range of the network (the address doesn’t belong to the IP subset of the network). If the Ethernet network is connected to the Internet, this is certain. In this case, a new IP address for the Toolkit is required. Contact the local network administrator to be assigned a free IP address for the Toolkit, then See “Using the Web Server Terminal Software” on page 7. for a description on how to configure the Toolkit’s IP address.

In the remainder of this document, the IP address 169.254.111.111 is used as an example. Exchange this IP address with the IP address you have set up in all the occurrences.

Figure 5. The PC is Connected to the EIT through a Network

Testing the Connection

To test the connection between the PC and the Internet Toolkit a simple program called ping can be used. Ping sends a number of messages to the specified IP address and displays the response. The ping program can be run from the command line or from a DOS window on the PC, as follows:

- Open the Windows® Start Menu.
- Click Run.
- In the Open box, type: “ping 169.254.111.111”.

If the network connection is OK, the program will respond with:

"Reply from 169.254.111.111" and information about the response time.

If there is a problem with the network setup the program will respond:

"Destination host unreachable". There may be two solutions for this problem:

- If the PC is connected to a network, change the IP address to an address accessible from the local network, as described in “The PC is Connected In Network” on page 5.
- If the Toolkit is connected directly to the PC (or through a hub), change the PC’s IP address to one in the same address range as the Toolkit, as described in “The PC is Not Connected to Network” on page 2.

If there is a problem with the Embedded Internet Toolkit the program will respond:
"Request timed out", this means that the Toolkit can not respond to messages. Check power connection, or perform a reset of the board by pressing the “RESET” button.

When the ping program is running it is using a DOS window on the PC. If the window is closing too fast to see the message, open a DOS window and type “ping 169.254.111.111”. The text will not disappear in this window.

Viewing Web Pages

The Embedded Internet Toolkit is shipped with example web pages programmed into the Flash memory. To view these web pages, a web browser such as Internet Explorer or Netscape is needed.

When using the Embedded Internet Toolkit there is no DNS (Domain Name Server) to recognize the IP address and assign a symbolic name for it (for instance www.atmel.com). To use symbolic names for the Embedded Internet Toolkit, contact the local network administrator and ask for a symbolic name for a specified IP address.

To view the default resident web pages in the Toolkit, start the web browser and write “169.254.111.111” into the address line of the browser window. The main page of the Embedded Internet Toolkit will now be displayed in the browser window.

Figure 6. Viewing the Default Web Page in a Web Browser

If no web page is displayed, go back to “Setting Up and Testing the Ethernet Connection” on page 2 and test if the network connection to the Toolkit is established. If the Toolkit replies to the ping messages, check the setup of the web browser. If the Internet Toolkit is directly connected to the same network as the PC, “direct connection to the network” or “bypass proxy server for local addresses” should be selected in the web browser configuration menu. If the Internet Toolkit is connected to the PC through a firewall, a proxy server should be selected in the configuration menu. Contact the local network administrator for information about the network configuration.
Installing the Web Server Terminal Software

The Embedded Internet Toolkit includes software for configuring the Toolkit. For a complete description of the configuration settings, please see the AVR Web Server documentation.

The web server terminal software is included on the CD-ROM provided with the Toolkit. To install the web server terminal software on the PC, click on the “PC software” link on the CD-ROM main page. This will copy all required files to the hard disk and add the web server icon to the start menu on the PC. The PC may need to be restarted after the installation.

Using the Web Server Terminal Software

To install the web server terminal software on the PC, click on the “PC software” link on the CD-ROM main page. This will copy all required files to the hard disk and add the web server icon to the start menu on the PC. The PC may need to be restarted after the installation.

To start the web server terminal software, open the start menu, select Programs and AVR Web Server Terminal to start the software. To load the default setting, open the File menu and select Load. Figure 7 shows the settings in the web server terminal software.

Note: The Toolkit’s network connection must be running correctly and the LINKLED on the board must be on in order to successfully connect to the web terminal software. If the network connector is not plugged in, the Embedded Internet Toolkit will not be initialized.

Figure 7. Web Server Terminal Window

The various settings are explained below.
Web Server Setup

DHCP Enable
If DHCP (Dynamic Host Configuration Protocol) is enabled, the web server will automatically initialize the IP address from a DHCP host. Use of DHCP requires a DHCP host to be set up on the network. “DHCP enable” disables manual IP address setup.

IP Address
Sets up the IP (Internet Protocol) address of the web server. Make sure the IP address is available on the local network. For complete description of IP addresses, see the AVR Web Server documentation.

MAC Address
Configures the MAC (Media Access Control) address of the web server. The MAC address must be a 48-bit hex value. For complete description of MAC address, see the AVR Web Server documentation.

E-mail Setup
The AVR Embedded Web Server can be configured to send e-mails to an e-mail address specified in the web server terminal. The sender and receiver address can be written directly into the e-mail setup section. The Host name is used to identify the web server to the mail server. The e-mail server IP address specifies the address of the e-mail server.

FTP Setup
The FTP setup section specifies the user name and password to log on to the AVR Embedded Web Server using FTP (File Transfer Protocol).

Write
The software writes the configuration settings to a local file called “server.ini”. When the write button is pressed the local file is transferred via the RS-232 serial interface to the Internet Toolkit. Make sure that an RS-232 cable is connected between the PC and the Internet Toolkit and that the Toolkit’s network connection is running correctly before pressing the write button.

The file is transferred to the Internet Toolkit using the ymodem protocol. The default settings are 9600 baud, no parity, 8 data bits, and 1 stop bit (9600, n, 8, 1). In the setting menu, the UART settings can be changed from their default values in the Settings menu.

The new settings become operative the next time the EIT is reset or powered up.

Figure 8. Writing Configuration to the Toolkit

Ping
The web server terminal software includes a ping for testing the communication to the Internet Toolkit. When clicking the Ping choice in the Tools menu, the program will ping the address currently in the IP Address field, and display the result in a DOS window. For an explanation of the ping responses, please see “Setting Up and Testing the Ethernet Connection” on page 2.
Web Browser

If Internet Explorer is installed on the PC, the web server terminal can be used as a web browser. Simply click the View menu and then web browser to display the web contents of the address specified in the IP Address field.

Server.ini

The web server terminal program generates a configuration file called server.ini with the following format:

[System]
DHCP=0
IP0=A9FE
IP1=6F6F
MAC0=0004
MAC1=25FF
MAC2=0010

[SMTP]
sender=anybody@anywhere.com
receiver=anybody@anywhere.com
host=anyhost
maillp0=A9FE
maillp1=6F60

[FTP]
FTP=1
Username=ews
Password=ews
Uploading Web Pages to the Toolkit

The Embedded Internet Toolkit includes 256 Kbytes of Flash memory that can be accessed remotely from the network with FTP (File Transfer Protocol) or via RS-232 and ymodem protocol from a terminal program (For instance Hyperterm). The files can be of any type, web pages, pictures, applications or JAVA applets being the most common ones.

The simplest way of using FTP is from a DOS window. To open a DOS window in Windows® 95 and Windows® 98, click the start menu, program and MS-DOS Prompt. Alternatively, click the start menu, click run and type command. In the DOS window type ftp 169.254.111.111 (or any other address set up with the web server terminal program).

Figure 9 below shows a screen shot of the logon screen.

**Figure 9. Using FTP from a DOS Window**
To view the files in the file system, type “ls” or “dir”. To transfer files from a location on the PC to the Toolkit, type “put name.ext”, where name.ext is the name of the file. To transfer files from the Toolkit to the PC type “get name.ext” where name.ext is the name of the file. Files in the file system can not be overwritten, and must therefore be deleted before re-written. To delete a file, type “rm name.ext”. To change the directory from which you want to transfer the files from your PC, type “LS directory” where directory is the target path on your PC. For more information, type “?”.

The file server.ini contains the configuration settings of the Toolkit, and should not be deleted from the file system. The file index.htm is the default file that is displayed when the Toolkit’s IP address is entered in a web browser window.

The dataflash file system can also be accessed from FTP programs with Windows interface. The file system has been tested with CuteFTP® (www.globalscape.com).

**Figure 10.** Listing of Files in the File System
Modifying the Software

Modifying the source code of the Toolkit software requires programming knowledge in C language. The software for the Internet Toolkit is divided into modules for the various functions. For complete descriptions of the functions in the software, please see the technical documentation included with the Toolkit.

This example explains how to use the IAR compiler for compiling the files to build a hex file for downloading into the Internet Toolkit.

For new users of the IAR C-compiler, it is recommended to complete the tutorial included in the C-compiler documentation.

Figure 11. Files Included in the Full Configuration
Figure 11 shows the files an IAR project including all the files necessary to use all software modules. To save code space, unused modules may be removed. The code size for the modules included in Figure 7 is approximately 30 Kbytes with maximum size compression. Figure 12 shows the settings for the output file format. Intel-extended should be selected as file format.

Figure 13 shows the settings for the linker file. A linker command file is included with the code. This linker command file should be selected.

The project can now be built. The.hex file can be downloaded to the Toolkit as explained below.

**Downloading New Software**

When a.hex file has been generated by the C-compiler, it must be downloaded into the Toolkit. This downloading can be done with the AT90ISP programing cable or with the STK500 starter kit. The documentation for these tools explains the required connections. When connecting the programmer to the 6-pin ISP header on the Toolkit board, make sure that the cable is connected the right way round.
Formatting the File System

To format the file system of the EIT Dataflash, short-circuit pins 1 and 2 of the Expansion Port header on the EIT while resetting it.

Figure 13. Specifying Linker File
Trouble-shooting guide

To be used with the Embedded Internet Quick Start Guide, which describes how to connect the Embedded Internet Toolkit, plus the use of FTP and web browsers.

Table 1. Troubleshooting Guide

<table>
<thead>
<tr>
<th>No</th>
<th>Checkpoint</th>
<th>Y/N</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Is the LAN LED on and is the LINK LED flashing with short pulses?</td>
<td>NO</td>
<td>No network connection is detected. The Ethernet cable is either not plugged in or wrong type of cable is used. For connection to a network with a hub or switch, a normal network cable can be used. For direct connection to a PC network card, a twisted cable must be used.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>YES</td>
<td>A network connection is detected, the Toolkit is connected to the network</td>
</tr>
<tr>
<td>2</td>
<td>Does the Toolkit respond to PING requests?</td>
<td>NO</td>
<td>Either the Toolkit or the PC is set up with wrong IP address. To change the IP address of the Toolkit, use the terminal program included on the Toolkit CD. Note that the file must be saved as &quot;server.ini&quot; before pressing the &quot;write&quot; button in the terminal program. A network connection (checkpoint 1) must be established before the terminal program can communicate with the Toolkit. To change the IP address of a PC, use the Windows &quot;control panel -&gt; network -&gt; TCP/IP properties&quot; and set up an IP address close to the Toolkit IP address. I.e. as the Toolkit is shipped with a default IP address of 169.254.111.111, the PC can be set up with IP address 169.254.111.150</td>
</tr>
<tr>
<td></td>
<td></td>
<td>YES</td>
<td>The PC and the Toolkit are set up with a correct IP address and they are able to communicate with each other</td>
</tr>
<tr>
<td>3</td>
<td>Can the Toolkit communicate with a DOS FTP program?</td>
<td>NO</td>
<td>The default user name and password is &quot;ews&quot;. Check that the user name and password are written in lowercase</td>
</tr>
<tr>
<td></td>
<td></td>
<td>YES</td>
<td>The user has access to the flash file system</td>
</tr>
<tr>
<td>4</td>
<td>Can the default web pages be accessed in a web browser?</td>
<td>NO</td>
<td>This is normally caused by the setup of the web browser. In the &quot;options&quot; or &quot;preferences&quot; menu, check that the web browser is configured for direct network connection or local area network and NOT using a proxy server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>YES</td>
<td>No problems</td>
</tr>
</tbody>
</table>